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IN THE UNITED STATES PATENT AND TRADEMARK OFFICE an'-.__:::: 
anc~ 

UTILITY APPLICATION AND FEE TRANSMITTAL §(1.53(b)) 

Commissioner for Patents 
Box Patent Application 
Washington, D.C. 20231 

Sir: 

Transmitted herewith for filing is the patent application of 

110_._. 
U•· -== ..., = 

Inventor(s) names and addresses: Keith R. McNally. San Diego. CA: WJ Kitchen. Rancho Santa 
Fe, CA: Ken Rogers. San Diego. CA: Paul Rubin. San Diego. CA 

For: INFORMATION MANAGEMENT AND SYNCHRONOUS COMMUNICATIONS 
SYSTEM WITH MENU GENERATIQN. AND HANDWRITING AND VOICE 
MODIFICATION OF ORDERS 

Enclosed Are: 

30 page(s) of specification 
1 page(s) of Abstract 
.5. page( s) of claims 
~ sheets (Figs. 1-9) of [2;] Formal D Informal drawings 
.8. page( s) of Declaration and Power of Attorney 

[2] Unsigned 
D Newly Executed 
D Copy from prior application 
D Deletion of inventors including Signed Statement under 37 C.P.R.§ 1.63(d)(2) 

661057 vl 
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Docket No. 3125-4003 

[g) REQUEST AN:Q CERT,IFICATION UNDER 35 U.S.C. §122(b)(2)(B)(i) (form 
PTO/SB/35) 
As indicated on the attached Request and Certification, Applicant(s) certify that the 
invention disclosed in the attached application HAS NOT and WILL NOT be the subject of 
an application filed in another country, or under a multilateral agreement, that requires 
publication at eighteen months after filing. Applicant(s) therefore request(s) that the 
attached application NOT be published under 35 U.S.C. §122(b). 

D Incorporation by Reference: 

0 The entire disclosure of the prior application, from which a copy of the combined 
Declaration and Power of Attorney is supplied herein, is considered as being part of 
the disclosure of the accompanying application and is incorporated herein by 
reference. 

0 Deletion oflnventors (37 C.F.R. §1.63(d) and §1.33(b) 

Signed statement attached deleting inventor(s) named in the prior application serial no. 
__ , filed __ . 

D Microfiche Computer Program (Appendix) 

0 page( s) of Sequence Listing 

0 

0 computer readable disk containing Sequence Listing 
0 Statement under 37 C.F.R. §1.821(±) that computer and paper copies of the Sequence 

Listing are the same 

Assignment Papers (assignment cover sheet and assignment documents) 

0 A check in the amount of $40.00 for recording the Assignment 
0 Charge the Assignment Recordation Fee to Deposit Account No. 13-4500, Order 

No. __ . 

D Assignment Papers filed in the parent application Serial No. 

0 Certification of chain of title pursuant to 37 C.F.R. §3.73(b) 

0 Priority is claimed under 35 U.S. C. § 119 for: 
Application No(s). __ ,filed __ , in __ (country). 

0 Certified Copy ofPriority Document(s) [ __ ] 
0 filed herewith 
0 filed in application Serial No. filed __ . 

0 English translation document(s) l---J 

0 filed herewith 
0 filed in application Serial No. __ , filed __ . 

0 Priority is claimed under 35 U.S.C. §119(e) for: 
Provisional Application No. __ , filed __ . 

-2-
661057 vl 
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Docket No. 3125-4003 

Information Disclosure Statement 
~' 

0 Copy of [ J cited references 

D PTO Form-1449 

0 References cited in parent application Serial No. __ , filed __ . 

Related Case Statement under 37 C.P.R. § 1.98(a)(2)(iii) 

0 A copy of related pending U.S. Application(s) Serial No(s): __ ,filed __ , 
respectively, is attached hereto. 

D A copy of related pending U.S. Application(s) entitled, __ , filed __ to 
inventor(s) __ ,respectively, is attached hereto. 

D A copy of each related application(s) was submitted in parent application serial no. 
__ , filed __ . 

Preliminary Amendment 

Return receipt postcard (MPEP 503) 

This is a 0 continuation divisional rg) continuation-in-part of prior application 
serial no. 09/400A13, filed September 21.1999, to which priority under 35 U.S.C. § 120 is 
claimed. 

0 Cancel in this application original claims __ of the parent application before 
calculating the filing fee. (At least one original independent claim must be retained 
for filing purposes.) 

0 A Preliminary Amendment is enclosed. (Claims added by this Amendment have 
been properly numbered consecutively beginning with the number following the 
highest numbered original claim in the prior application). 

[g) The status of the parent application is as follows: 

0 A Petition for Extension of Time and a Fee therefor has been or is being filed in the 
parent application to extend the term for action in the parent application until __ . 

0 A copy of the Petition for Extension of Time in the co-pending parent application is 
attached. 

!8J No Petition for Extension of Time and Fee therefor are necessary in the co-pending 
parent application. 

0 Please abandon the parent application at a time while the parent application is pending or 
at a time when the petition for extension of time in that application is granted and while 
this application is pending has been granted a filing date, so as to make this application 
co-pending. 

0 Transfer the drawing(s) from the parent application to this application 

0 Amend the specification by inserting before the first line the sentence: 
This is 0 continuation 0 divisional 0 continuation-in-part of co-pending application 
Serial No. __ , filed __ . 

-3-
661057 vl 
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Docket No. 3125-4003 

I. CALCULATION OF APPLICATION FEE 

Basic Fee 
Number Filed Number Extra Rate $740.00/370.00 

Total Claims* 26-20 = 6x $18.00/$9.00 $ 54.00 

Independent Claims 4- 3 lx $84.00/ $42.00 $ 42.00 

[8J Multiple Dependent Claims If marked, add fee of$280.00 ($140.00) $ 140.00 

* Reflects total number of claims for fee purposes, with multiple dependent claims 
being counted according to 37 C.F.R. §1.75(c) 

TOTAL: $ 606.00 

~ Small entity status is or has been claimed. Reduced fees under 37 C.F.R. § 1.9 (f) paid 
herewith 
$606.00. 

D A check in the amount of$ __ in payment of the application filing fees is attached. 

~ Charge fee to Deposit Account No. 13-4500, Order No. 3125-4003. A DUPLICATE 
COPY OF THIS SHEET IS ATTACHED. 

The Commissioner is hereby authorized to charge any additional fees which may be 
required for filing this application pursuant to 3 7 CFR § 1.16, including all extension of 
time fees pursuant to 37 C.F.R. § 1.17 for maintaining copendency with the parent 
application, or credit any overpayment to Deposit Account No. 13-4500, Order No. 3125-
4003. A DUPLICATE COPY OF THIS SHEET IS ATTACHED. 

Dated: November 1, 2001 

Correspondence Address: 

MORGAN & FINNEGAN, L.L.P. 
345 Park A venue 
New York, NY 10154-0053 
(212) 758-4800 Telephone 
(212) 751-6849 Facsimile 

661057 vl 

By: 

Respectfully submitted, 
MORGAN & FINNEGAN, L.L.P. 
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Docket No. 3125-4003 
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IN THE UNITED STATES PATENT AND TRADEMARK OFFICE 

Applicant(s): McNally et al. 

Group Art Unit: TBA 

Serial No.: TBA 
Examiner: TBA 

Filed: Herewith 

For: INFORMATION MANAGEMENT AND SYNCHRONOUS COMMUNICATIONS 
SYSTEM WITH MENU GENERATION, AND HANDWRlTING AND VOICE 
MODIFICATION OF ORDERS 

EXPRESS MAIL CERTIFICATE 

Express Mail Label No.: EL606933355US 

Date of Deposit: November 1, 2001 

I hereby certify that the following attached paper(s) and/or fee 

1. Utility Application and Fee Transmittal Form; 
2. Combined Declaration and POA; 
5. Patent Application (Specs. 29 pgs., Claims 5 pgs. Abstract 1 pg.) 
6. Drawings (8 sheets- Figs. 1-9) 
5. Return Receipt Postcard. 

is being deposited with the United States Postal Service "Express Mail Post Office to Addressee" 
service under 37 C.F.R. §1.10 on the date indicated above and is addressed to BOX CPA, 
Commissioner for Patents, Washington, D.C. 20231. 

Correspondence Address: 

MORGAN & FINNEGAN, L.L.P. 
345 Park Avenue 
New York, NY 10154-0053 
(212) 758-4800 Telephone 
(212) 751-6849 Facsimile 

661263 vl 

Jesus Raul Remedios 
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EXPRESS MAIL CERTIFICATE NO. EL6069333'55US 
PATENT W' ..t .. Attorney Docket No. 3125-4003 

UNITED STATES PATENT APPLICATION 

2 For: 

3 INFORMATION MANAGEMENT AND SYNCHRONOUS COMMUNICATIONS 
4 SYSTEM WITH MENU GENERATION, AND HANDWRITING AND VOICE 

~.~,s MODIFICATION OF ORDERS 

~,~8 Inventors: 

660374 vl 
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UNITED STATES PATENT APPLICATION 

OF: KEITH R. McNALLY 
WJKITCHEN 
KEN ROGERS 
PAUL RUBIN 

FOR: INFORMATION MANAGEMENT AND SYNCHRONOUS 
COMMUNICATIONS SYSTEM WITH MENU 
GENERATION, AND HANDWRITING AND VOICE 
MODIFICATION OF ORDERS 

The present application is a continuation-in-part of application Serial No. 

09/400,413, filed September 21, 1999. The contents of application Serial No. 09/400,413 are 

incorporated herein by reference. 

FIELD OF THE INVENTION 

Ho8 This invention relates to an information management and synchronous 

~~~ communications system and method for generation of computerized menus for restaurants and 

~b other applications with specialized display and synchronous communications requirements 
tr~:i:: 

21 related to, for example, the use of equipment or software with non-PC-standard graphical 

22 formats, display sizes and/or applications for use in remote data entry, information management 

23 and synchronous communication between host computer, digital input device or remote pager 

24 via standard hardwired connection, the internet, a wireless link, smart phone or the like. 

25 BACKGROUND OF THE INVENTION 

26 While computers have dramatically altered many aspects of modem life, pen and 

27 paper have prevailed in the hospitality industry, e.g., for restaurant ordering, reservations and 

28 wait-list management, because of their simplicity, ease of training and operational speed. For 

- 2-

660374 vl 
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, 

1 example, ordering prepared foods has historically been done verbally, either directly to a waiter . ' 

2 or over the telephone, whereupon the placed order is recorded on paper by the recipient or 

3 instantly filled. 

4 Although not previously adapted for wide-scale use in the hospitality industry, 

5 vanous forms of digital wireless communication devices are in common use, e.g., digital 

6 wireless messengers and pagers. Also in common use are portable laptop and handheld devices. 

7 However, user-friendly information management and communication capability not requiring 

8 extensive computer expertise has not heretofore been available for use in everyday life such as 

for restaurant ordering, reservations and wait-list management. Hundreds of millions of dollars 

;10 have been spent on personal digital assistant ("PDA") development seeking to produce a small, 
?~~ 

light-weight and inexpensive device that could be adapted to such uses; yet none have yielded a 

,,,b2 satisfactory solution. 

~lk3 One of the inherent shortcomings of PDA type devices is that, as they strive for 

{114 small size, low weight and low cost, they must compromise the size and clarity of the operator 

q~ display medium interface itself, which in most cases is one of a variety of LCD (liquid crystal 
~~~k 

16 display) type devices. As the size of the display shrinks, the amount of information that may be 

17 displayed at any one point or time is commensurately decreased, typically requiring multiple 

18 screens and displays to display information to the operator. This reduces the overall utility of the 

19 device. Additionally, the smaller display and keyboard results in a non-optimal operator 

20 interface, which slows down operation and is thus unacceptable for the time criticality of 

21 ordering, reservation and wait-list management and other similar applications. This necessitates 

22 many design compromises which in the aggregate have resulted in limited acceptance of PDA 

23 type devices in the restaurant and hospitality fields. 

- 3-
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1 Many of the negatives p;evalent in earlier devices have been eliminated, but, to . . 
2 date, there is still no integrated solution to the ordering/waitlist/reservation problem discussed 

3 above. With the advent of the Palm® and other handheld wireless devices, however, the efforts 

4 to make such devices ubiquitous have begun to bear fruit at least in some areas, e.g., personal 

5 calendars. However, substantial use of such devices in the restaurant and hospitality context has 

6 not occurred to date. As discussed above, at least one of the reasons PDAs have not been 

7 quickly assimilated into the restaurant and hospitality industries is that their small display sizes 

8 are not readily amenable to display of menus as they are commonly printed on paper or displayed 

~"k9 on, e.g., large, color desktop computer screens. Another reason is that software for fully 

~~0 realizing the potential for wireless handheld computing devices has not previously been 

available. Such features would include fast and automatic synchronization between a central 

tr~ database and multiple handheld devices, synchronization and communication between a World 

;1;3 Wide Web ("Web") server and multiple handheld devices, a well-defined application program 
~~h 

~W interface ("API") that enables third parties such as point of sale ("POS") companies, affinity 

f!p program companies and internet content providers to fully integrate with computerized 

16 hospitality applications, real-time communication over the internet with direct connections or 

17 regular modem dialup connections and support for batch processing that can be done periodically 

18 throughout the day to keep multiple sites in synch with the central database. A single point of 

19 entry for all hospitality applications to communicate with one another wirelessly has also 

20 previously been unavailable. Such a single point of entry would work to keep all wireless 

21 handheld devices and linked Web sites in synch with the backoffice server (central database) so 

22 that the different components are in equilibrium at any given time and an overall consistency is 

23 achieved. For example, a reservation made online would be automatically communicated to the 

- 4-
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1 backoffice server and then sy~chroniz'ed with all the wireless handheld devices wirelessly. 

2 Similarly, changes made on any of the wireless handheld devices would be reflected 

3 instantaneously on the backoffice server, Web pages and the other handheld devices. 

4 For the foregoing reasons, paper-based ordering, waitlist and reservations 

5 management have persisted in the face of widespread computerization in practically all areas of 

6 commerce. At most, computerization of these functions has been largely limited to fixed 

7 computer solutions, i.e., desktop or mainframe, because of the problems heretofore faced in 

8 configuring wireless handheld devices and maintaining database synchronization for such 

applications. Specifically, the unavailability of any simple technique for creating restaurant 

menus and the like for use in a limited display area wireless handheld device or that is 

~!n compatible with ordering over the internet has prevented widespread adoption of 

"'1!2 computerization in the hospitality industry. Without a viable solution for this problem, 

organizations have not made the efforts or investments to establish automated interfaces to 

handheld and Web site menus and ordering options. 

~~ A principal object of the present invention is to provide an improved information 

16 management and synchronous communications system and method which facilitates user-

17 friendly and efficient generation of computerized menus for restaurants and other applications 

18 that utilize equipment with non-PC-standard graphical formats, display sizes and/or applications. 

19 A further object of the present invention is to provide an improved information 

20 management and synchronous communications system and method which provides for entry, 

21 management and communication of information from the operator as well as to and from another 

22 computer, Web page menu, remote digital device using a standard hardwired connection, the 

23 internet or a wireless link. 

- 5-
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A further object ?f the present invention is to provide an improved information 

2 management and synchronous communications system which is small, affordable and 

3 lightweight yet incorporates a user-friendly operator interface and displays menus in a readily 

4 comprehensible format. 

5 A further object of the present invention is to provide a synchronous information 

6 management and communications system which enables automatic updating of both wireless and 

7 internet menu systems when a new menu item is added, modified or deleted from any element of 

8 the system. 

SUMMARY OF THE INVENTION 

The foregoing and other objects of the present invention are provided by a 

synchronous information management and communications system and method optimized for 

)h simplicity of operation which incorporates menu generation for creation of menus to be used 
'' ::.,...,:.. 
;-"' 

~lG with wireless remote handheld computer and PDA devices, the internet or any application where 

W4 simple and efficient generation of menus is appropriate. The menu generation approach of the 

~1'5 present invention includes a desktop software application that enables the rapid creation and 

16 building of a menu and provides a means to instantly download the menu configuration onto, 

17 e.g., a handheld device or Web page and to seamlessly interface with standard point of sale 

18 ("POS") systems to enable automatic database updates and communication exchanges when a 

19 change or input occurs in any of the other system elements. To solve the above and other related 

20 problems, an information management and communications system is provided which results in 

21 a dramatic reduction in the amount of time, and hence cost, to generate and maintain 

22 computerized menus for, e.g., restaurants and other related applications that utilize non-PC-

23 standard graphical formats, display sizes or applications. 

- 6-
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1 The menu generation approach of the present invention has many advantages over 

2 previous approaches in solving the problem of converting paper-based menus or Windows® PC-

3 based menu screens to small PDA-sized displays and Web pages. In one embodiment, the 

4 present invention is a software tool for building a menu, optimizing the process of how the menu 

5 can be downloaded to either a handheld device or Web page, and making manual or automatic 

6 modifications to the menu after initial creation. 

7 Manual modifications to the generated menus include handwritten screen captures 

8 and/or voice recorded message captures coupled with the standard menus and modifiers 

generated according to standard choices . Such manual modifications enable an extremely rapid 

f,~o and intuitive interface to enhance operations and further optimize the overall operator interface. 

This approach solves a long-standing, operational issue in restaurant/hotel/casino food/drink 

'''1.2 ordering when customers want something unusual and not anticipated and available through 

hig normal computerized selections. As seen in Figure 8, the operator screen on the hand-held can 
~~b 

~~ capture handwritten information specific to a customers requests directly on the touch-sensitive 
~~b 

screen of the wireless computing device. This additional information can then be coupled with 

16 the fixed menu and modifier information generated automatically from the hospitality 

17 application software and the combined message can be sent to a restaurant point of sale (POS) 

18 system, printer or/or display system. This unique operator interface enables universal languages 

19 and an unlimited set of information to be manually communicated and exchanged. The resultant 

20 combined message of one or more fixed indications selected from a menu of a device such as a 

21 hand-held, and dynamic handwritten messages and/or data provides an even more powerful tool 

22 than either modality used independently. 

- 7-
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1 For example a re?taurant'server taking a drink order could select from a menu of 

2 her hand-held device's screen "Iced Tea", and then manually write in the literal screen of her 

3 hand-held "with lemon" as shown in Figure 8. The manually-written information could, for 

4 example, be printed or displayed in front of a bartender preparing the drink order. The indication 

5 "Iced Tea" as selected from a menu of the hand-held would also be presented to the bartender, 

6 perhaps by printing and/or screen display. The server can also select any printer from within the 

7 hospitality establishment directly from the operator interface on the screen of the hand-held and 

8 have either the order or the receipt printed out where it is most convenient and efficient. 

Similarly, a server taking a drink order could select from a menu of her hand-held 

device's screen "Iced Tea", and then record the voice message "with lemon" using her hand-held 

~m device integral microphone. The recorded information could, for example, be played on a 

''1.!2 speaker attached to a computer, POS system, or the like located near the bartender or chef 

!1~ preparing the order. The indication "Iced Tea" as selected from a menu of the hand-held would 
s::o:::: 

~i, also be presented to the bartender/chef, perhaps by printing and/or screen display. Both the literal 

screen capture method and the voice recorded message method combine the power of automatic 

16 fixed menu generation with the expanded flexibility to resolve operational issues that exist 

17 throughout the hospitality market without this innovative solution. Additionally, in certain 

18 embodiments, hand-writing and voice recognition technologies can be utilized to convert the 

19 manual operator inputs into appropriate text messages which can be combined with the 

20 computer generated menu options to convey the combined information to, for example, a 

21 bartender or chef. 

22 Similarly, hand-held devices can link the above innovations to individual 

23 customers at specific tables through a graphical user interface on the hand-held screen that 

- 8 -
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' 
assigns each customer a number.within a table. For example, table 20 might have 6 customers (1-

2 6) and each customer has a different order, By enabling the linkage of the orders to specific 

3 customer positions within the table and accessible from the hand-held screen, the servers can 

4 easily track and link the specific orders to the specific customers. 

5 The use of wireless handheld devices in the restaurant and hospitality industry is 

6 becoming increasingly pervasive as restaurant owners and managers become more aware of the 

7 benefits. With the proper wireless handheld system in place, restaurants can experience 

8 increased table turns from improved server productivity and shorter order taking and check 

paying times. Restaurants and POS companies seeking to provide a wireless handheld interface 

~Io to their desktop-based POS systems or a Web page equivalent face several challenges. These 

Uil challenges include building a menu using their existing database and transferring the menu onto 

"'Iil2 handheld devices or Web pages that will interface with servers wirelessly or to 

h3 restaurants/customers over the internet. The menu generation approach of the present invention 
~d: 

~~~ is the first coherent solution available to accomplish these objectives easily and allows one 

development effort to produce both the handheld and Web page formats, link them with the 

16 existing POS systems, and thus provides a way to turn a complicated, time-consuming task into a 

17 simple process. 

18 The information management and synchronous communications system of the 

19 present invention features include fast synchronization between a central database and multiple 

20 handheld devices, synchronization and communication between a Web server and multiple 

21 handheld devices, a well-defined API that enables third patiies such as POS companies, affinity 

22 program companies and internet content providers to fully integrate with computerized 

23 hospitality applications, real-time communication over the internet with direct connections or 

- 9-
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regular modem dialup connections and support for batch processing that can be done periodically 
' 

2 throughout the day to keep multiple sites in synch with the central database. 

3 The communication module also provides a single point of entry for all hospitality 

4 applications, e.g., reservations, frequent customer ticketing, wait lists, etc. to communicate with 

5 one another wirelessly and over the Web. This communication module is a layer that sits on top 

6 of any communication protocol and acts as an interface between hospitality applications and the 

7 communication protocol and can be easily updated to work with a new communication protocol 

8 without modifying the core hospitality applications. An exemplary system diagram of such a 

communications systemic relationship is shown in Figure 9 and serves as an example of the 

power of the synchronization element of the invention through a common, linked solution. A 

single point of entry works to keep all wireless handheld devices and linked web sites in synch 

~1E2 with the backoffice server applications so that the different components are in equilibrium at any 

f-rS given time and an overall consistency is achieved. For example, a reservation made online can 
(~::~~ 

~4 be automatically communicated to the backoffice server and then synchronized with all the 
u::~~ 

wireless handheld devices wirelessly. Similarly, changes made on any of the wireless handheld 

16 devices are reflected instantaneously on the backoffice server Web pages and the other handheld 

17 devices. 

18 BRIEF DESCRIPTION OF THE DRAWINGS 

19 The foregoing features and advantages of the present invention can be appreciated 

20 more fully from the following description, with references to the accompanying drawings in 

21 which: 

- 10-
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' 
1 FIG. 1 is a schematic representation of a window displayed on a computer display 

2 screen which shows a hierarchical tree menu, modifier window and sub-modifier window in 

3 conformity with a preferred embodiment of the present invention. 

4 FIG. 2 is a schematic representation of a modifier dialog box in conformity with a 

5 preferred embodiment of the present invention. 

6 FIG. 3 is a schematic representation of a menu category dialog box in conformity 

7 with a preferred embodiment of the present invention. 

8 FIG. 4 is a schematic representation of a menu item dialog box in conformity with 

a preferred embodiment of the present invention. 

~Io FIG. 5 is a schematic representation of a display customization dialog box in 

WI conformity with a preferred embodiment of the present invention. 

c'l~ FIG. 6 is a schematic representation of a communications control window in 

i'I3 conformity with a preferred embodiment of the present invention. 
~-~b 

FIG. 7 is a schematic representation of a point of sale interface on a wireless 

~~ handheld device for use in displaying page menus created in conformity with a preferred 

16 embodiment of the present invention. 

17 FIG. 8 is an example of a literal, hand-written screen according to embodiments 

18 of the present invention. 

19 FIG. 9 is an exemplary system diagram relating to embodiments of the present 

20 invention. 

21 DETAILED DESCRIPTION OF THE INVENTION 

22 Most personal computers today run under an operating system that provides a 

23 graphical user interface ("GUI") for accessing user applications. A GUI is used in the preferred 
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1 embodiment of the present invention. Through' an interface of windows, pull-down menus, and 
' 

2 toolbars, GUI operating systems have simplified PCs and have rendered computer technology 

3 more user friendly by eliminating the need to memorize keyboard entry sequences. In addition, 

4 GUis allow users to manipulate their data as they would physical entities. For example, a 

5 window can represent a file and the contents of the window can represent the records of the file. 

6 The window can be opened, closed, or set aside on a desktop as if it were an actual object. The 

7 records of the file can be created, deleted, modified and arranged in a drag-and-drop fashion as if 

8 they also were physical objects. The most common GUI operating systems that provide this 

"object-oriented" environment for personal computers are Microsoft Windows® systems, 

including Windows CE® for handheld wireless devices and the like. Generally, a particular 

application program presents information to a user through a window of a GUI by drawing 

s12 images, graphics or text within the window region. The user, in tum, communicates with the 

H8 application by "pointing" at graphical objects in the window with a pointer that is controlled by a 

h~ hand-operated pointing device, such as a mouse, or by pressing keys on a keyboard. 
~:<:~~~ 
·~~;:" 

~3 The use of menus is conventional in GUis for software applications. Menus are 

16 typically utilized to provide end users of applications with available choices or processing 

17 options while using the applications. For example, in a typical desktop or interactive application, 

18 selection of a "file" from a menu bar may cause display of a context menu which provides "file" 

19 options. File options can have additional subordinate or child options associated with them. If a 

20 file option having subordinate options is selected, the child options are displayed in context in a 

21 child menu or submenu proximate to the selected parent option. One or more of the child 

22 options provided in the child menu may have further subordinate options. Thus, such a menu 

23 system comprises cascading sets of menus which are displayable in context to show the 

- 12-

660374 vi 



 21Petitioners' Exhibit 1009, Page

1 parent/child relationships between options of the context menu. A menu system of this type is 

2 incorporated into the preferred embodiment of the invention. 

3 The preferred embodiment of the present invention uses typical hardware 

4 elements in the form of a computer workstation, operating system and application software 

5 elements which configure the hardware elements for operation in accordance with the present 

6 invention. A typical workstation platform includes hardware such as a central processing unit 

7 ("CPU"), e.g., a Pentium® microprocessor, RAM, ROM, hard drive storage in which are stored 

8 various system and application programs and data used within the workstation, modem, display 

screen, keyboard, mouse and optional removable storage devices such as floppy drive or a CD 

S~o ROM drive. The workstation hardware is configured by software including an operating system, 

UU e.g., Windows® 95, 98, NT or CE, networking software (including internet browsing software) 

1:2 and application software components. The preferred embodiment also encompasses a typical file 

server platform including hardware such as a CPU, e.g., Pentium® microprocessor, RAM, ROM, 

hard drive, modem, and optional removable storage devices, e.g., floppy or CD ROM drive. The 

server hardware is configured by software including an operating system, e.g., Windows® 95, 98, 

16 NT or CE, networking software (including Web server software) and database software. 

17 A computer workstation for use in the preferred embodiment also includes a GUI. 

18 As is conventional, the GUI is configured to present a graphical display on the display screen 

19 arranged to resemble a single desktop. Execution of an application program involves one or 

20 more user interface objects represented by windows and icons. Typically, there may be several 

21 windows and icons simultaneously present on the desktop and displaying information that is 

22 generated by different applications. 
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1 The window environment is gen~rally part of the operating system software that 

2 includes a collection of utility programs for controlling the operation of the computer system. 

3 The computer system, in tum, interacts with application programs to provide higher level 

4 functionality, including a direct interface with the user. Specifically, the application programs 

5 make use of operating system functions by issuing task commands to the operating system which 

6 then performs the requested task. For example, an application program may request that the 

7 operating system display certain information on a window for presentation to the user. 

8 An aspect of the preferred embodiment of the information management and 

communications system of the invention is shown in FIG. 1. FIG. 1 shows an example of the 

fib GUI provided by the operating system of the preferred embodiment of the present invention. 

UID. With reference to FIG. 1, the preferred embodiment includes an intuitive GUI 1 from which to 

'12 build a menu on a desktop or other computer. A hierarchical tree structure 2 is used to show the 

tt~ different relationships between the menu categories 3 (e.g., soups, salads, appetizers, entrees, 

deserts, etc.), menu items 4 (e.g., green salad, chicken caesar salad, etc.), menu modifiers 5 (e.g., 

dressing, meat temperature, condiments, etc.) and menu sub-modifiers 6 (e.g., Italian, French, 

16 ranch, bleu cheese, etc.). 

17 The procedure followed in configuring a menu on the desktop PC and then 

18 downloading the menu configuration onto the POS interface on the handheld device in 

19 conformance with the preferred embodiment is as follows. 

20 The menu configuration application is launched by clicking on the appropriate 

21 icon on the desktop display screen. FIG. 1 will then be displayed. There are three windows on 

22 the screen shown in FIG. 1. The left window is the menu tree 7, also called the tree view. The 

23 top right window is the Modifiers window 8 and the bottom right window is the Sub-Modifiers 
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1 window 9. The Sub-Modifiers window'lists the sub-modifiers that correspond to the modifier 
' 

2 that is selected. The views on the right are referred to as list views. There are several ways of 

3 invoking a command, including using the menu options; using the context menu (right mouse 

4 click); using the keyboard or using the toolbar icons. For example, if it is desired to add a 

5 category to the menu, the following four options are available: (1) clicking on Edit, Add 

6 Category; (2) right mouse clicking on Menu, then clicking on Add Category; (3) highlighting 

7 Menu, then typing Ctrl +Tor (4) clicking on the Add Category icon on the toolbar. To add an 

8 item to a category, the following options are available: (1) highlighting the category to which it 

is desired to add an item and then clicking on Edit> Add Item; (2) right mouse clicking on the 

~Ib desired category and then clicking on Add Item; (3) highlighting the desired category, then 

mi typing Ctrl + N or ( 4) clicking on the Add icon on the tool bar. 

"'12 When building a menu, it should be kept in mind that the menu items are stored 

~3 using a tree metaphor similar to how files are stored on a PC with folders and subfolders. The 
?::::i:: 

16 
17 
18 
19 
20 
21 
22 
23 
24 
25 
26 

27 

28 

menu structure is similar to the Windows® File Explorer in the way the items are organized 

hierarchically. Below is an example of how an item may be configured: 

Menu 
>> Entrees 

>> RedMeat 
>> NY Strip 

>> Vegetables 
>> Tomato 
>> Lettuce 
Meat Temperature 
>> Medium Rare 

In the above example, Menu is the root. Entrees is a menu category. Red Meat is an Entree 

category. NY Strip is a modifier. Vegetable is a modifier. Meat Temperature is a modifier. 

Medium Rare is a sub-modifier of Meat Temperature. 
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1 

2 

3 

4 

5 

6 

7 

8 
9 

' 
The steps taken in building a menu are as follows: 

1. 

2. 

3. 

4. 

5. 

6. 

7. 

Add Modifiers; 

Add Sub-Modifiers and link them to the Modifiers; 

Create Menu categories; 

Add menu items to the categories; 

Assign Modifiers to the menu items; 

Preview the menu on the POS emulator on the desktop PC; 

Download the menu database to the handheld device. 

I 0 To add modifiers, a user clicks on the inside of the Modifiers window, then (1) 

11 clicks on Edit>Add Modifier; (2) Presses Ctrl + N; (3) right mouse clicks in the Modifiers 

~~2 window, then clicks on Add Modifiers or (4) clicks on the Add icon from the toolbar. If a menu 

H3 is being built from scratch, the procedure is to enter the Long Name, Short Name, Code and 

~14 Price in the Modifier dialog box 10 shown in FIG. 2. The Long Name is the full descriptive 

'"i~5 name of the item. The Short Name is the abbreviated name that will be displayed on the 
s 
~~~ 
;16 handheld device. The Code is the numeric or alphanumeric code for the item. If there is an 
ii'"" 

existing database, the existing database can be browsed and menu items retrieved from the 

~8 database. Clicking on the Browse button will bring up the existing database of menu items. The 

19 item to be added is then selected and "OK" is clicked. The fields will then be filled·with the 

20 information from the database. Clicking on OK again will add the item as a modifier. To delete 

21 a modifier, the modifier is selected and the Delete key pressed on the keyboard. To edit a 

22 modifier, either the modifier is double clicked or the Enter key is pressed. 

23 Sub-modifiers represent the last level of modifiers that can be assigned to a menu 

24 tree. To add sub-modifiers, the modifier to which sub-modifiers are to be assigned is selected. 

25 Then, the focus is set on the sub-modifier window by clicking inside the Sub-Modifier window 

26 as follows: (1) clicking on Edit>Add Sub-Modifier; (2) pressing Ctrl + N; (3) right mouse 
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1 clicking in the Sub-Modifiers window, then clicking on Add Sub-Modifiers or (4) clicking on the 

2 Add icon from the tool bar. If a menu is being built from scratch, the procedure is to enter the 

3 Long Name, Short Name, Code and Price in a Sub-Modifier dialog box similar to the Modifier 

4 dialog box shown in FIG. 2. As with modifiers, the Long Name is the full descriptive name of 

5 the item. The Short Name is the abbreviated name that will be displayed on the handheld device. 

6 The Code is the numeric or alphanumeric code for the item. As before, if there is an existing 

7 database, the existing database can be browsed and menu items retrieved from the database. 

8 Clicking on the Browse button will bring up the existing database of menu items. The item to be 

added is then selected and OK clicked. The fields will then be filled with the information from 

the database. Clicking on OK again will add the item as a sub-modifier. To delete a sub-

modifier, the sub-modifier is selected and the Delete key depressed on the keyboard. To edit a 

sub-modifier, either the sub-modifier is double clicked or the Enter key is pressed. 

Menu categories are created from the root. Some examples of categories are 

Appetizers, Soups, Salads, Entrees, Desserts, etc. The first step is to click on Menu in the menu 

tree window. Categories are added by (1) clicking on the Add Category icon from the toolbar; 

16 (2) clicking on Edit > Add Category or (3) pressing Ctrl + T. As shown in FIG. 3, Menu 

17 Category dialog box 11 then appears in which to enter the Long and Short names for the menu 

18 category. 

19 To add menu items to categories, the menu category which is being built is 

20 clicked. For example, if items are being added to Appetizers, the Appetizers branch is clicked 

21 on. Then the Edit > Add Item is clicked on or Ctrl + N pressed. As before, if a menu is being 

22 built from scratch, the procedure is to enter the Long Name, Short Name, Code, Prep Time, 

23 Recipe and Price into the Menu Item dialog box 12 shown in FIG. 4. The Long Name is the full 
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2 
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4 

5 

6 

7 

8 

~"k9 

~l'{) 

~lll 

!~t2 
::,~~~ 

13 

. 
descriptive name of the item. The Short Name is the abbreviated name that will be displayed on . 
the handheld device. The Code is the numeric or alphanumeric code for the item. Prep Time is 

the time it takes to prepare the meal and Recipe would include preparation methods and 

ingredients that are used in the preparation of the item. If there is an existing database, the 

existing database can be browsed and menu items retrieved from the database. Clicking on the 

Browse button will bring up the existing database of menu items. The item to be added is then 

selected and OK is clicked. The fields will then be filled with the information from the database. 

Clicking on OK again will add the item to the category. 

Once the menu items have been entered, it may be desired to assign some 

modifiers to the menu items. For example, it may be desired to assign meat temperature to a 

steak order. To accomplish this, first the modifier to be assigned is selected, then the menu item 

on the tree view that is to be assigned the modifier is clicked on and then Edit > Assign Modifier 

is clicked on. Or, the modifier can simply be dragged and dropped onto the menu item to link 

them. A dialog box is then displayed asking if this modifier is a required modifier. If it is a 

required modifier, the display icon will be red but if it is a non-required modifier the display icon 

16 will be green. As many modifiers as are applicable can be assigned. If any changes are made to 

17 the modifiers, those changes will be automatically reflected throughout the menu tree. 

18 Once the modifiers have been entered, it may be desired to assign sub-modifiers 

19 to the modifiers items. For example, it may be desired to add Honey Mustard as a sub-modifier 

20 to Dressing. To accomplish this, first the modifier to be assigned a sub-modifier is selected, then 

21 the sub-modifier window is clicked on~ then Edit > Add Sub Modifier is clicked on, Ctrl+N 

22 entered or the Add icon from the toolbar is clicked on. Or, the sub-modifier can simply be 

23 dragged and dropped onto the modifier to link them. 

- 18-

660374 vi 



 27Petitioners' Exhibit 1009, Page

1 When the menu has beeri completely configured, it can be previewed on a POS 

2 emulator on the desktop to verify that the menu is correctly configured before downloading it to 

3 the handheld device. To preview, File > Preview Database is clicked on or the Preview Database 

4 icon from the toolbar is clicked on. The handheld POS emulator on the desktop can then be run. 

5 If the configuration is deemed acceptable, the handheld device is connected to the desktop PC to 

6 ensure that a connection has been established; the POS application on the handheld device is 

7 exited and File > Download Database is clicked on or the Download Database icon from the 

8 toolbar is clicked on. If there is an existing menu database on the handheld device, the system 

will ask if the existing database should be replaced. Yes is clicked if existing database 

ql() replacement is desired. 
~~b 

A database function enables the creation of, e.g., a breakfast menu, lunch menu 

ti~ and dinner menu and downloading them to a handheld device. Functions available are (1) 

~:13 creating a new database; (2) opening an existing database; (3) saving a database under a different 

!l~ name. To access these functions, File is clicked on the menu bar. 

The preferred embodiment encompasses customized layout, views and fonts. To 

16 set the focus on the view it is desired to change, click inside the desired window. The main 

17 customizing dialog box is accessed by clicking on View> Customize View. A dialog box 13, as 

18 shown in FIG. 5, will be displayed including tabs that allow the following options: selection of 

19 Columns to display in the list view by choosing and arranging the fields to display in the 

20 Modifiers and Sub-Modifiers windows; formatting Columns by specifying the column widths 

21 and justification; selecting Filter allows restricting the list to display only the items that meet 

22 certain criteria. For example, display of modifiers with codes between 500 and 550. Selecting 

23 Sort allows sorting the modifiers or sub-modifiers according to any of the available fields such as 
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1 Name, Code or Price. Selecting Style facilitates choice of font type, style, size, etc. To change 
• 

2 the font in a particular window, click on View > Fonts or right mouse click in the desired 

3 window and then click on Fonts. To change the size of the windows, drag the borders of the 

4 windows to expand or contract the size of the windows. To change the column widths, simply 

5 drag the edge of the column headers to increase or decrease the column widths. 

6 A communications control program monitors and routes all communications to 

7 the appropriate devices. It continuously monitors the wireless network access point and all other 

8 devices connected to the network such as pagers, remote devices, internet Web links and POS 

software. Any message received is decoded by the software, and then routed to the appropriate 

~l~O device. No user action is needed during operation of the software once the application has been 

launched. To launch the communications control module, a Wireless Traffic icon is clicked on 

'"12 the desktop PC. When the program loads, the screen shown in FIG. 6 appears. Messages 

H3 received are logged in the window 14 shown in FIG. 6 with a time stamp. The messages are also 
~::~ 

logged to a file on the hard drive. This provides a mechanism to monitor all traffic across the 
::;:;:'t< 

:IS network (possibly useful for troubleshooting, or maintenance, but not necessary for normal 
w':".~~~ 

16 operation). The program may be minimized so the screen is not displayed on the desktop, but it 

17 must be running for proper communications to exist between all devices on the network 

18 As stated, the preferred embodiment of the present invention includes the use of 

19 and compatibility with GUI technology. A drag-and-drop approach is used for organizing the 

20 tree structure 2 in the generated menu. Drag-and-drop is also used for assigning modifiers 

21 (modifiers can be dragged from the modifiers window 5 and dropped onto the menu item 4 for 

22 assignment). In-cell editing results in fast editing of items in building the menus. Customizable 

23 fonts enable users to change font types, style and size. Customizable layouts enable users to 
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1 resize windows, change icons and display preferences. The inventive approach provides for . 
2 fully persistent storage between sessions, even if a session is improperly or abruptly terminated. 

3 Font and the tree state (i.e., which nodes are expanded/collapsed) are stored between sessions. 

4 Layout for modifiers and sub-modifiers list views (filter, columns, formatting, font, etc.) are 

5 stored between sessions. The last database used is likewise stored between sessions. Splitter 

6 views allow the user to see different views at the same time. Each view is displayed on its own 

7 section of the screen. Views can be resized via the keyboard or a mouse by simply dragging the 

8 splitter in the middle. 

An automated function is provided to import existing POS databases into the 
,,,., 
;,lb inventive menu generation system and, as discussed above with respect to the detailed example 
~~~b 

of how to use the preferred embodiment, an automated download procedure is provided to 

transfer the desktop database onto a handheld device and/or Web page. Also as discussed, the 

i-l 

iJ-,3 preferred embodiment facilitates preview of the handheld device or Web page version of the 

~~ POS menu on the desktop before downloading and configuration. Customizable desktop menu 

generation is contemplated, as discussed above, in the form of custornizable fonts, columns, 

16 layouts, etc. The inventive approach also includes templates for common modifiers that can be 

17 assigned to similar menu items. The preferred embodiment also supports multiple databases, 

18 thus providing for the creation and storing of different menu databases on handheld devices such 

19 as breakfast, lunch or dinner menus. The user can then select the appropriate database to reflect 

20 the time of day. 

21 FIG. 7 is a schematic representation of a point of sale interface 15 for use in 

22 displaying a page-type menu 16 created using the inventive menu generation approach. As can 

23 be seen from FIG. 7, the page menu is displayed in a catalogue-like point-and-click format 
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1 whereas the master menu, FIG. 1, is displayed 'as a hierarchical tree structure. Thus, a person 

2 with little expertise can "page through" to complete a transaction with the POS interface and 

3 avoid having to review the entire menu of FIG. 1 to place an order. A PDA or Web page format 

4 could appear like FIG. 7 or the display could be configured for particular requirements since 

5 fully customizable menu generation and display are contemplated. 

6 The POS interface on the handheld device supports pricing in the database or 

7 querying prices from the POS server. The POS device also can be customized with respect to 

8 "look and feel" for the particular version. As can be seen in FIG. 7, the POS interface provides 

for billing, status and payment with respect to orders. A myriad of options can be provided 

HbO depending on the application. 

Advanced database functions are provided in the preferred embodiment of the 

"'t2 invention, including an automated download process onto handheld devices and/or Web sites. In 
;:; 

the preferred embodiment, the menu generation system of the present invention uses an API 
.:~:. 

~~ called ActiveX Data Objects ("ADO") for database access. ADO is useful in a variety of F ...... 

~::.~ 
11-.D settings. It is built on top of OLE DB and can be used to talk to databases and, in the future, any 

16 data source with any OLE DB driver. Advanced querying is supported. The database can be 

17 queried on virtually all fields. Queries can be built using SQL syntax for experienced users or 

18 can be created using a query builder which guides users through the creating process. Advanced 

19 error handling is supported. Errors occurring at run time can be trapped. A descriptive message 

20 is displayed to alert the user and provide error information. However, the application does not 

21 terminate when the errors happen. The source code is easy to maintain and modify, thus 

22 allowing for on time delivery of customized versions of the software. The advanced database 

23 functions produce well-designed databases that accommodate growth and scalability 
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The inventive menu generation ~pproach provides a solution for the pervasive 

2 connectivity and computerization needs of the restaurant and related markets. The inventive 

3 solution includes automatic database management and synchronization, PDA and handheld 

4 wireless operating system integration and optimization, wireless communications and internet 

5 connectivity, user interface design, and graphics design. 

6 In the preferred embodiment, the menu generation approach of the present 

7 invention uses Windows CE® as the operating system for the handheld devices. Windows CE® 

8 provides the benefits of a familiar Windows 95/98/NT® look and feel, built-in synchronization 

~·~ between handheld devices, internet and desktop infrastructure, compatibility with Microsoft 

~ib Exchange®, Microsoft Office 9® and TCP/IP quick access to information with instant-on feature. 
~"b 

Windows CE® provides a basic set of database and communication tools for 

~i~ developer use. However, interfacing with these tools to provide application specific results can 

~3 be a complex task. In addition to the menu generation described above, a set of software 

libraries described herein in conforn1ance with the present invention not only enhances the basic 

Windows CE® functionality by adding new features but also maximizes the full potential of 

16 wireless handheld computing devices. Such features include fast synchronization between a 

17 central database and multiple handheld devices, synchronization and communication between a 

18 Web server and multiple handheld devices, a well-defined API that enables third parties such as 

19 POS companies, affinity program companies and internet content providers to fully integrate 

20 with computerized hospitality applications, real-time communication over the internet with direct 

21 connections or regular modem dialup connections and support for batch processing that can be 

22 done periodically throughout the day to keep multiple sites in synch with the central database. 
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1 The synchronous. communicatio~s control module discussed above provides a 

2 single point of entry for all hospitality applications to communicate with one another wirelessly 

3 or over the Web. This communications module is a layer that sits on top of any communication 

4 protocol and acts as an interface between hospitality applications and the communication 

5 protocol. This layer can be easily updated to work with a new communication protocol without 

6 having to modify the core hospitality applications. The single point of entry works to keep all 

7 wireless handheld devices and linked Web sites in synch with the backoffice server (central 

8 database) so that the different components are in equilibrium at any given time and an overall 

~,9 consistency is achieved. For example, a reservation made online is automatically communicated 

!~lb to the backoffice server which then synchronizes with all the wireless handheld devices 

wirelessly. Similarly, changes made on any of the wireless handheld devices will be reflected 

instantaneously on the backoffice server and the other handheld devices. 

The software applications for performing the functions falling within the 
::' 

~; described invention can be written in any commonly used computer language. The discrete 

fl'$ programming steps are commonly known and thus programming details are not necessary to a 

16 full description of the invention. 

17 A simple point-to-point wireless capability is contemplated which permits simple 

18 digital messages to be sent from the wireless handheld devices to a receiver in a beeper and/or 

19 valet parking base-station. The POS interface of FIG. 7 is representative of the display on a 

20 typical wireless device used in conformity with the invention. A simple protocol is used to 

21 acknowledge receipt of the message and thus simultaneous communication is not necessary, 

22 which reduces the cost of the wireless link. The range of the wireless link is determined by the 

23 characteristics of the radio transceiver. Adding a wireless link allows paging of beeper equipped 
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1 customers directly from the operator' interface on the wireless handheld devices and . 
2 communication to and from various input/output transmitters and receivers to update the status 

3 of the order, reservation or other information and thus further reduce the workload on the 

4 operator and enable operations to proceed much faster. This link could also be hardwired or 

5 otherwise implemented using any two-way messaging transport. 

6 A further aspect of the invention is the use of the menus generated in accordance 

7 with the described technique to place orders from wireless remote handheld devices or from 

8 remote locations through the internet. The World Wide Web is a distributed hypermedia 

~:~ computer system that uses the internet to facilitate global hypermedia communication using 
':l~::" 

i',] 

~0 specified protocols. One such protocol is the Hypertext Transfer Protocol ("HTTP"), which 

~n facilitates communication of hypertext. Hypertext is the combination of information and links to 

'}Q other information. In the context of the Web, hypertext is defined by the Hypertext Mark-up 

~~~ Language ("HTML"). The links or hyperlinks in a HTML docmnent reference the locations of 
~r.:~ 

l:4 resources on the Web, such as other HTML documents. Another language used in creating 
r"~ 
~:~ 
~:S documents for use on the Worldwide Web, to display on computer screens, or to create speech 

16 style sheets for use in, e.g., telephones, is the Extensible Mark-Up Language ("XML"). XML is 

17 a "metalanguage", i.e., a language for describing languages which was developed to eliminate 

18 the restrictions ofHTML. 

19 The Web is a client-server system. The HTML documents are stored on Web 

20 server computers, typically in a hierarchical fashion with the root document being referred to as 

21 the home page. The client specifies a HTML document or other source on the server by 

22 transmitting a Uniform Resource Locator ("URL") which specifies the protocol to use, e.g., 

23 HTTP, the path to the server directory in which the resource is located, and filename of the 
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1 resource. Users retrieve the documents via client computers. The software running on the user's 

2 client computer that enables the user to view HTML documents on the computer's video monitor 

3 and enter selections using the computer's keyboard and mouse is known as a browser. The 

4 browser typically includes a window in which the user may type a URL. A user may cause a 

5 URL to be transmitted by typing it in the designated window on the browser or by maneuvering 

6 the cursor to a position on the displayed document that corresponds to a hyperlink to a resource 

7 and actuating the mouse button. The latter method is commonly referred to simply as "clicking 

8 on the hot-spot" or "clicking on the hyperlink". The hyperlink methodology is contemplated for 

~"~'9 use in accordance with the preferred embodiment to transmit orders via the internet. 

Web server application software exists that enables a user to shop for and order 

merchandise. Such systems are sometimes referred to as electronic merchandising systems or 

~"1' 
:,lQ virtual storefronts. Systems that enable a user to choose among several retailers' goods are -::: 

;,::: 

p3 sometimes referred to as electronic malls. An electronic retailer's or electronic mall operator's 

m4 Web server provides HTML forms that include images and descriptions of merchandise. The 

user may conventionally search for an item by entering a key word search query in a box on a 

16 form. When a user selects an item, the server may provide a linked form that describes that item 

17 in further detail. The user may also conventionally enter ordering information into boxes on the 

18 form, such as the type and quantity of the item desired. The information entered by the user is 

19 transmitted to the server. The user may select multiple items in this manner and then enter a 

20 credit card number to pay for the purchases. The retailer processes the transaction and ships the 

21 order to the customer. As can be appreciated, ordering merchandise can also be done from 

22 menus. The generation of menus of items or merchandise for sale over the internet is readily 

23 accomplished by the menu generation approach of the present invention. 
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1 Searching for items that the user is interested in purchasing is insufficient in prior . 
2 merchandising systems. Database management programs use index searching to facilitate rapid 

3 searching of large amounts of data. The creator of the database may instruct the program to use 

4 specified fields in the database as indexed or key fields. The program locates all terms in the 

5 database that appear in the indexed fields and stores them in an index table. Each entry in the 

6 index table includes a term and corresponding pointer to the location in the database where the 

7 term is found. If a user initiates a search for a term that is present in the index table, the program 

8 can locate the instances of that term in the database with exceptional speed. Users who are 

~A,) familiar with the particular database they are searching will generally know which fields are 

Y:D indexed and will know the format of the data in those fields. For example, a user of a database 

containing the inventory of a bookstore may know that users can search for the names of authors 

~'2 of books and that a user who wishes to do so should enter the author's last name first. A user 
or~~~ 

~,9, having such knowledge will therefore be able to search efficiently. Users of electronic 

~1 merchandising systems, however, are generally end-consumers who have no knowledge of a 

i':$ merchant's database. If, as is very likely, such a user initiates a search for a term that is not 

16 present in the index table, the program must sequentially search through all records in the 

17 database. Sequential records are typically linked by pointers. Using pointers in this manner is 

18 very demanding on server resources, resulting not only in an exceptionally slow search, but also 

19 creating a bottleneck for other processes that the server may be executing. The menu generation 

20 approach of the present invention can be used to create customized menus from a database that 

21 includes every item of merchandise the vendor has for sale. In this manner, customers can scan 

22 the generated menu much more readily than they could view the entire database and the 
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1 necessity of having familiarity with the 'databa~e is eliminated as well, reducing the need for 

2 resource intensive pointers. 

3 While the preferred embodiment of the invention is for the generation of 

4 restaurant menus and the like, the broad scope of the invention is far greater. For example, 

5 menus generated in accordance with the invention can be used in the desktop computing 

6 environment in association with the operating system or application programs. One such use is 

7 to facilitate the creation of user personalized file structures for general desktop use. Another use 

8 is to facilitate the location of customized menus from master menus for use in association with 

~,~ application software to make the execution of the application software more efficient by, e.g., 

~:~ 
1'~0 eliminating the necessity of querying or checking every tree branch in the master menu file 
.~:;;;::-

ll!l structure in response to user input or other criteria and to create handheld/FDA compatible 

versions of the software. 

i~ While the preferred embodiment of the invention includes the selection of items 
if;::;;::: 

L~ from a master menu wherein the master menu is displayed using a graphical user interface, it is 
~rJ 

to be appreciated that any means for displaying the master menu to the user and generating 

16 another menu in response to and comprised of the selections made is encompassed by the 

17 contemplated invention. The invention encompasses the selection of nontextual symbols, 

18 characters, icons and the like, in addition to text, from a hierarchical tree menu or the like for 

19 generation of another menu comprised of such items. 

20 It is also within the scope of the invention to generate menus automatically in 

21 response to predetermined criteria. For example, in the restaurant menu generation embodiment, 

22 a modified menu can be generated to comply with a particular specification or group of criteria 

23 such as, e.g., "dinner", "low cholesterol", "low fat", "fish", "chicken", or "vegetarian". In this 
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1 embodiment, only items from the master inenu that satisfy specified parameters will be included 

2 in the generated menu. The selection process could involve selection of master menu items 

3 based on tags or identifiers associated with the items or by checking every master menu item 

4 against a dictionary of items acceptable for inclusion in the modified menu. It should also be 

5 appreciated that the invention encompasses any combination of automatic and manual user 

6 selection of the items comprising the generated menu. For example, a user might specifY criteria 

7 which would further control automatic selection or the user could manually select some items 

8 with automatic selection of others. The menu generation aspect of the invention is equally 

, 9 applicable to table-based, drive-thru, internet, telephone, wireless or other modes of customer 
l?~·l 

:ft:lt: 

iP order entry, as is the synchronous communications aspect of the invention. 

ID'1 The inventive concept encompasses the generation of a menu in any context 

q1 known to those skilled in the art where an objective is to facilitate display of the menu so as to 
·:~ .. 1~ 

~ 3 enable selection of items from that menu. The restaurant menu generation embodiment is but 
~~b 

I~ one example of a use for the inventive concept. Likewise, displaying menus generated in 
rl:i~~ 

accordance with the invention on PDAs and Web pages to facilitate remote ordering are but a 

16 few examples of ways in which such a menu might be used in practice. Any display and 

17 transmission means known to those skilled in the art is equally usable with respect to menus 

18 generated in accordance with the claimed invention. 

19 In the more general situation, menus can be generated in accordance with the 

20 present invention in a variety of situations. For example, the usable file structure for a particular 

21 data processing application can be dictated by the user or an application program prior to or 

22 during the execution of the application program. Efficiencies with respect to computational 
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1 speed and equipment, e.g., storage and 'processor, usage can thus be achieved along with the 

2 facilitation of display of the generated menu. 

3 While the best mode for carrying out the preferred embodiment of the invention 

4 has been illustrated and described in detail, those familiar with the art to which the invention 

5 relates will recognize various alternative designs and embodiments which fall within the spirit of 

6 practicing the invention. The appended claims are intended to cover all those changes and 

7 modifications falling within the true spirit and scope of the present invention. 

-30-

660374 vl 



 39Petitioners' Exhibit 1009, Page

1 That which is claimed is: ' 

2 1. An information management and synchronous communications system for 

3 generating and transmitting menus comprising; 

4 a. a central processing unit, 

5 b. a data storage device connected to said central processing unit, 

6 c. an operating system including a graphical user interface, 

7 d. a first menu consisting of menu categories, said menu categories 
8 consisting of menu items, said first menu stored on said data storage device and displayable in a 
9 window of said graphical user interface in a hierarchical tree format, 

Ho e. a modifier menu stored on said data storage device and displayable in a 
window of said graphical user interface, 

h~ f. a sub-modifier menu stored on said data storage device and displayable in 
t~ a window of said graphical user interface, and 

~t4 g. application software for generating a second menu from said first menu 
''t~ and transmitting said second menu to a wireless handheld computing device or Web page, 
~ 

tfp wherein the application software facilitates the generation of the second menu by 

e:;:;~ 

b:;~ 

allowing selection of categories and items from the first menu, addition of menu categories to the 

f:l8 second menu, addition of menu items to the second menu and assignment of parameters to items 

19 in the second menu using the graphical user interface of said operating system, said parameters 

20 being selected from the modifier and sub-modifier menus, wherein said second menu is manually 

21 modified after generation. 

22 2. An information management and synchronous communications system for 

23 generating menus comprising: 

24 

25 
26 

660374 vl 

a. 

b. 

a central processing unit, 

a data storage device connected to said central 
processing unit, 
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1 
2 

3 

4 
5 

c. 

d. 

e. 

an operating system including a graphical user 
interface, 

a first menu stored on said data storage device, 

application software for generating a second menu 
from said first menu, 

6 wherein the application software facilitates the generation of the second menu by 

7 allowing selection of items from the first menu, addition of items to the second menu and 

8 assignment of parameters to items in the second menu using the graphical user interface of said 

9 operating system and wherein data comprising the second menu is synchronized between the 

J 0 data storage device connected to the central processing unit and at least one other computing 
~l~b. 

device, wherein said second menu is manually modified by handwriting or voice recording after 

generation. 

~3 3. An information management and synchronous communications system for 

<l 4 generating menus comprising: 

18 
19 
20 
21 

22 

23 
24 

25 

a. a microprocessor, 

b. 

c. 

d. 

e. 

f. 

g. 

a display device, 

a data and instruction input device, 

a data storage device for storing information and 
instructions entered through said data and 
instruction input means or information generated by 
said microprocessor, 

an operating system, 

a master menu stored on said data storage device for 
generating a modified menu, and 

application software, 

26 wherein said microprocessor, operating system and application software are operative to display 

27 the master menu on the display device in response to instructions programmed into said 
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1 microprocessor, operating system, application software and information and instructions entered 

2 through said data input device, and wherein said microprocessor, operating system and 

3 application software are operative to create the modified menu from said master menu in 

4 response to information and instructions entered through said data and instruction input device 

5 and wherein data comprising the modified menu is synchronized between the data storage device 

6 and at least one other computing device, wherein said modified menu is manually modified after 

7 generation. 

8 4. In a computer system having an input device, a storage device, a video display, 

~,,~ an operating system including a graphical user interface and application software, an information 

management and synchronous communications method comprising the steps of: 

20 
21 
22 

23 

a. outputting at least one window on the video display; 

b. 

c. 

d. 

e. 

f. 

g. 

outputting a first menu in a window on the video 
display; 

displaying a cursor on the video display; 

selecting items from the first menu with the input 
device or the graphical user interface; 

inserting the items selected from the first menu into 
a second menu, the second menu being output in a 
window; 

optionally adding additional items not included in 
the first menu to the second menu using the input 
device or the graphical user interface; 

storing the second menu on the storage device; and 

24 synchronizing the data comprising the second menu between the storage device 

25 and at least one other data storage medium, wherein the other data storage medium is connected 

26 to or is part of a different computing device, and wherein said second menu is manually modified 

27 after generation. 
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5. The infonnation management' and synchronous communications system of 

2 claim 1, 2, or 3 wherein the manual modification involves handwriting capture. 

3 6. The infonnation management and synchronous communications system of 

4 claim 1, 2, or 3 wherein the manual modification involves voice capture. 

5 7. The method of claim 4 wherein the manual modification involves 

6 handwriting capture. 

7 8. The method of claim 4 wherein the manual modification involves voice 

8 capture. 

9. The system of claim 1 wherein the modified second menu can be 

selectively printed on any printer directly from the graphical user interface 

of a hand-held device. 

10. The system of claim 1 wherein the modified second menu can be linked to 

a specific customer at a specific table directly from the graphical user 

interface of a hand-held device. 

11. The system of claim 2 or 3 wherein the modified second menu can be 

16 selectively printed on any printer directly from the graphical user interface 

17 of said other computing device. 

18 12. The system of claim 2 or 3 wherein the modified second menu can be 

19 linked to a specific customer at a specific table directly from the graphical 

20 user interface of said other computing device. 

21 13. The system of claim 5 wherein the handwriting capture involves 

22 handwriting recognition and conversion to text. 
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1 

2 

3 

4 

5 

6 

. ' ~ 
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14. 

15. 

16. 

The system of claim 6 wherein the voice capture involves voice 

recognition and conversion to text. 

The method of claim 7 wherein the handwriting capture involves 

handwriting recognition and conversion to text. 

The method of claim 8 wherein the voice capture involves voice 

recognition and conversion to text 
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1 ABSTRACT 

2 An information management and synchronous communications system and 

3 method facilitates database equilibrium and synchronization with wired, wireless and Web-based 

4 systems, user-friendly and efficient generation of computerized menus and reservations with 

5 handwritten/voice modifications for restaurants and other applications that utilize equipment 

6 with nonstandard graphical formats, display sizes and/or applications for use in remote data 

7 entry, information management and communication with host computer, digital input device or 

8 remote pager via standard hardwired connection, the internet, a wireless link, printer or the like. 
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Docket No. 3125-4003 

COMBINED DECLARATION AND POWER OF ATTORNEY FOR 
ORIGINAL, DESIGN, NATIONAL STAGE OF PCT, SUPPLEMENTAL, 

DIVISIONAL, CONTINUATION OR CONTINUATION-IN-PART APPLICATION 

As a below named inventor, I hereby declare that: 

My residence, post office address and citizenship are as stated below next to my name, 

I believe I am the original, first and sole inventor (if only one name is listed below) or an original, first 
and joint inventor (if plural names are listed below) of the subject matter which is claimed and for which 
a patent is sought on the invention entitled: 

INFORMATION MANAGEMENT AND SYNCHRONOUS COMMUNICATIONS SYSTEM 
WITH MENU GENERATION. AND HANDWRITING AND VOICE MODIFICATION OF 
ORDERS 

the specification of which 

a. 1:81 is attached hereto 

b. D was filed on as application Serial No. and was amended on . (if 
applicable). 

PCT FILED APPLICATION ENTERING NATIONAL STAGE 

c. D was described and claimed in International Application No. filed on 
as amended on . (if any). 

I hereby state that I have reviewed and understand the contents of the above-identified specification, 
including the claims, as amended by any amendment referred to above. 

and 

I acknowledge the duty to disclose information which is material to patentability as defined in 37 C.P.R. 
§ 1.56. 

I hereby specify the following as the correspondence address to which all communications about this 
application are to be directed: 

SEND CORRESPONDENCE TO: John W. Osborne 
MORGAN & FINNEGAN, L.L.P. 
345 Park A venue 
New York, N.Y. 10154 

DIRECT TELEPHONE CALLS TO: 212-415-8529 

0 I hereby claim foreign priority benefits under Title 35, United States Code§ 119 (a)-( d) or under 
§ 365(b) of any foreign application(s) for patent or inventor's certificate or under§ 365(a) of any 
PCT international application(s) designating at least one country other than the U.S. listed below 
and also have identified below such foreign application(s) for patent or inventor's certificate or 
such PCT international application(s) filed by me on the same subject matter having a filing date 
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within twelve (12) months before t~at of the application on which priority is claimed: 

0 The attached 35 U.S.C. § 119 claim for priority for the application(s) listed below forms a part of 
this declaration. 

Country/PCT 
Application 

Number 
Date of filing 

(day, month, vr) 
Date of issue 

( dav, month, vr) 
Priority 
Claimed 

0 I hereby claim the benefit under 35 U.S.C. § 119(e) of any U.S. provisional application(s) listed 
below. 

Provisional Application No. Date of :filing (day, month, yr) 

ADDITIONAL STATEMENTS FOR DIVISIONAL, CONTINUATION OR CONTINUATION-IN­
PART OR PCT INTERNATIONAL APPLICATION(S DESIGNATING THE U.S.) 

I hereby claim the benefit under Title 35, United States Code§ 120 of any United States application(s) or 
under§ 365(c) of any PCT international application(s) designating the U.S. listed below. 

09/400,413 
US/PCT Application Serial No. 

US/PCT Application Serial No. 

September 21, 
1999 
Filing Date 

Filing Date 

Allowed 
Status (patented, pending, abandoned)/ U.S. 
application no. assigned (For PCT) 

Status (patented, pending, abandoned)/ U.S. 
application no. assigned (For PCT) 

In this continuation-in-part application, insofar as the subject matter of any of the claims of this 
application is not disclosed in the above listed prior United States or PCT international 
application(s) in the manner provided by the first paragraph of Title 35, United States Code,§ 
112, I acknowledge the duty to disclose material information as defined in Title 37, Code of 
Federal Regulations,§ 1.56(a) which occurred between the filing date of the prior application(s) 
and the national or PCT international filing date of this application. 

I hereby declare that all statements made herein of my own knowledge are true and that all statements 
made on information and belief are believed to be true; and further that these statements were made with 
the knowledge that willful false statements and the like so made are punishable by fine or Imprisonment, 
or both, under Section 1001 of Title 18 of the United States Code and that such willful false statements 
may jeopardize the validity of the application or any patent issued thereon. 
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I hereby appoint the following attorneys anc;Vor agents with full power of substitution and revocation, to 
prosecute this application, ,to receive the patent, and to transact all business in the Patent and Trademark 
Office connected therewith: John C. Vassil (Reg. No. 19,098), Alfred P. Ewert (Reg. No. 19,887), David 
H. Pfeffer (Reg. No. 19,825), Harry C. Marcus (Reg. No. 22,390), Robert E. Paulson (Reg. No. 21,046), 
Stephen R. Smith (Reg. No. 22,615), Kurt E. Richter (Reg. No. 24,052), J. Robert Dailey (Reg. No. 
27,434), Eugene Moroz (Reg. No. 25,237), John F. Sweeney (Reg. No. 27,471), Arnold I. Rady (Reg. No. 
26,601), Christopher A. Hughes (Reg. No. 26,914), WilliamS. Feiler (Reg. No. 26,728), Joseph A. 
Calvaruso (Reg. No. 28,287), James W. Gould (Reg. No. 28,859), Richard C. Komson (Reg. No. 27,913), 
Israel Blum (Reg. No. 26,710), Bartholomew Verdirame (Reg. No. 28,483), Maria C.H. Lin (Reg. No. 
29,323), Joseph A. DeGirolamo (Reg. No. 28,595), Michael P. Dougherty (Reg. No. 32,730), Seth J. 
Atlas (Reg. No. 32,454), Andrew M. Riddles (Reg. No. 31,657), Bruce D. DeRenzi (Reg. No. 33,676), 
Mark J. Abate (Reg. No. 32,527), John T. Gallagher (Reg. No. 35,516), Steven F. Meyer (Reg. No. 
35,613) and Kenneth H. Sonnenfeld (Reg. No. 33,285), Tony V. Pezzano (Reg. No. 38,271), Andrea L. 
Wayda (Reg. 43,979), Walter G. Hanchuk (Reg. No. 35,179), John W. Osborne (Reg. No. 36,231), and 
Robert K. Goethals (Reg. No. 36,813) of Morgan & Finnegan, L.L.P. whose address is: 345 Park Avenue, 
New York, New York, 10154; and MichaelS. Marcus (Reg. No. 31,727), John E. Hoel (Reg. No. 
26,279), and Stanley B. Green (Reg. No. 24,351) ofMorgan & Finnegan, L.L.P., whose address is 1775 
Eye Street, Suite 400, Washington, D.C. 20006. 

0 I hereby authorize the U.S. attorneys and/or agents named hereinabove to accept and follow 
instructions from as to any action to be taken in the U.S. Patent and Trademark Office 
regarding this application without direct communication between the U.S. attorneys and/or agents 
and me. In the event of a change in the person(s) from whom instructions may be taken I will so 
notify the U.S. attorneys and/or agents named hereinabove. 

Full name of sole or first inventor: Keith R. McNally 

Inventor's signature* 
Date 

Residence: 5104 Seagrove Cove, San Diego, CA 92130 

Citizenship: U.S. 

Post Office Address: 

Full name of second inventor: WJ Kitchen 

Inventor's signature* 
Date 

Residence: Rancho Santa Fe, CA 92067 

Citizenship: 11..S.. 

Post Office Address: P.O. Box 675387, Rancho Santa Fe, CA 92067 

ATTACHED IS ADDED PAGE TO COMBINED DECLARATION AND POWER OF 
ATTORNEY FOR SIGNATURE BY THIRD AND SUBSEQUENT INVENTORS FORM. 
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. 
Full name of third inventor: ' Ken Rogers 

Inventor's signature* 
Da1 

Residence: 2801 Oceanfront Walk #M, San Diego. CA 92109 

Citizenship: U.S. 

Post Office Address: 

Full name of fourth inventor: Paul Rubin 

Inventor's signature* 
-

Date 
Residence: 9573 vervain Street, San Diego CA 92129 

Citizenship: us. 
Post Office Address: 

Full name of fifth inventor: 

Inventor's signature* 
Date 

Residence: 

Citizenship: 

Post Office Address: 

Full name of sixth inventor: 

Inventor's signature* 
Date 

Residence: 

Citizenship: 

Post Office Address: 

Full name of seventh inventor: 

Inventor's signature* 

Date 
Residence: 

Citizenship: 

Post Office Address: 
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' 

Full name of eighth inventor ' 

Inventor's signature* 
Date 

Residence: 

Citizenship: 

Post Office Address: 

Full name of ninth inventor: 

Inventor's signature* 
Date 

Residence: 

Citizenship: 

Post Office Address: 

Full name of tenth inventor: 

Inventor's signature* 
Date 

Residence: 

- Citizenship: 

Post Office Address: 

Full name of eleventh inventor: 

Inventor's signature* 

Date 

Residence: 

Citizenship: 

Post Office Address: 
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*Before signing this declar,ation, each person signing must: 

1. Review the declaration and verify the correctness of all information therein; and 

2. Review the specification and the claims, including any amendments made to the claims. 

After the declaration is signed, the specification and claims are not to be altered. 

To the inventor(s): 

The following are cited in or pertinent to the declaration attached to the accompanying 
application: 

Title 3 7, Code ofF ederal Regulation, § 1.56 

Duty to disclose information material to patentability 

(a) A patent by its very nature is affected with a public interest. The public interest is best served, and the most 
effective patent examination occurs when, at the time an application is being examined, the Office is aware 
of and evaluates the teachings of all information material to patentability. Each individual associated with 
the filing and prosecution of a patent application has a duty of candor and good faith in dealing with the 
Office, which includes a duty to disclose to the Office all information known to that individual to be 
material to patentability as defined in this section. The duty to disclose information exists with respect to 
each pending claim until the claim is canceled or withdrawn from consideration, or the application becomes 
abandoned. Information material to the patentability of a claim that is canceled or withdrawn from 
consideration need not be submitted if the information is not material to the patentability of any claim 
remaining under consideration in the application. There is no duty to submit information which is not 
material to the patentability of any existing claim. The duty to disclose all information known to be 
material to patentability is deemed to be satisfied if all information known to be material to patentability of 
any claim issued in a patent was cited by the Office or submitted to the Office in the manner prescribed by 
§§1.97(b)-(d) and 1.98. However, no patent will be granted on an application in connection with which 
fraud on the Office was practiced or attempted or the duty of disclosure was violated through bad faith or 
intentional misconduct. The Office encourages applicants to carefully examine: 

(1) prior art cited in search reports of a foreign patent office in a counterpart application, and 

(2) the closest infonnation over which individuals associated with the filing or prosecution of a 
patent application believe any pending claim patentably defines, to make sure that any 
material information contained therein is disclosed to the Office. 

Title 35, U.S. Code§ 101 

Inventions patentable 

Whoever invents or discovers any new and useful process, machine, manufacture, or composition of 
matter, or any new and useful improvement thereof, may obtain a patent therefor, subject to the 
conditions and requirements of this title. 

Title 35 U.S. Code§ 102 

Conditions for patentability; novelty and loss of right to patent 

A person shall be entitled to a patent unless --
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(a) the invention }Vas known or used by others in this country, or patented or described in a 
printed publication in this or a foreign country, before the invention thereof by the applicant 
for patent, 

(b) the invention was patented or described in a printed publication in this or foreign country or 
in public use or on sale in this country, more than one year prior to the date of application for 
patent in the United States, or 

(c) he has abandoned the invention, or 

(d) the invention was first patented or caused to be patented, or was the subject of an inventor's 
certificate, by the applicant or his legal representatives or assigns in a foreign country prior 
to the date of the application for patent in this country on an application for patent or 
inventor's certificate filed more than twelve months before the filing of the application in the 
United States, or 

(e) the invention was described in a patent granted on an application for patent by another filed 
in the United States before the invention thereof by the applicant for patent, or on an 
international application by another who has fulfilled the requirements of paragraphs (1), (2), 
and (4) of section 371(c) of this title before the invention thereof by the applicant for patent, 
or 

(f) he did not himself invent the subject matter sought to be patented, or 

(g) before the applicant's invention thereof the invention was made in this country by another 
who had not abandoned, suppressed, or concealed it. In determining priority of invention 
there shall be considered not only the respective dates of conception and reduction to 
practice of the invention, but also the reasonable diligence of one who was first to conceive 
and last to reduce to practice, from a time prior to conception by the other. 

Title 35, U.S. Code§ 103 

Conditions for patentability; non-obvious subject matter 

A patent may not be obtained though the invention is not identically disclosed or described as set forth in 
section 1 02 of this title, if the differences between the subject matter sought to be patented and the prior 
art are such that the subject matter as a whole would have been obvious at the time the invention was 
made to a person having ordinary skill in the art to which said subject matter pertains. Patentability shall 
not be negatived by the manner in which the invention was made. 

Subject matter developed by another person, which qualifies as prior art only under subsection (f) or (g) 
of section 102 of this title, shall not preclude patentability under this section where the subject matter and 
the claimed invention were, at the time the invention was made, owned by the same person or subject to 
an obligation of assignment to the same person. 

Title 35, U.S. Code § 112 (in part) 

Specification 

The specification shall contain a written description of the invention, and of the manner and process of 
making and using it, in such full, clear, concise and exact terms as to enable any person skilled in the art 
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to which it pertains, or witb which it is most nearly connected, to make and use the same, and shall set 
forth the best mode contemplated by the inventor of carrying out his invention. 

Title 35, U.S. Code,§ 119 

Benefit of earlier filing date in foreign country; right of priority 

An application for patent for an invention filed in this country by any person who has, or whose 
legal representatives or assigns have, previously regularly filed an application for a patent for the same 
invention in a foreign country which affords similar privileges in the case of applications filed in the 
United States or to citizens of the United States, shall have the same effect as the same application would 
have if filed in this country on the date on which the application for patent for the same invention was 
first filed in such foreign country, if the application in this country is filed within twelve months from the 
earliest date on which such foreign application was filed; but no patent shall be granted on any application 
for patent for an invention which had been patented or described in a printed publication in any country 
more than one year before the date of the actual filing of the application in this country, or which had 
been in public use or on sale in this country more than one year prior to such filing. 

Title 35, U.S. Code, § 120 

Benefit or earlier filing date in the United States 

An application for patent for an invention disclosed in the manner provided by the first paragraph 
of section 112 of this title in an application previously filed in the United States, or as provided by section 
363 of this title, which is filed by an inventor or inventors named in the previously filed application shall 
have the same effect, as to such invention, as though filed on the date of the prior application, if filed 
before the patenting or abandonment of or termination of proceedings on the first application or an 
application similarly entitled to the benefit of the filing date of the first application and if it contains or is 
amended to contain a specific reference to the earlier filed application. 

Please read carefully before signing the Declaration attached to the accompanying Application. 

If you have any questions, please contact Morgan & Finnegan, L.L.P. 
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